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Add an Appointment

There are several ways to add an appointment or message. One way is to highlight the desired time slot 
in the day planner and double click the mouse button or press enter. Alternatively you may click the Add 
button at the bottom of the screen, or select Add from the Edit Menu.

Any of these options will open the Add A Message dialog box.

Here you may enter a Message, use the Category Selection to select the Category, select a Frequency, a
Priority if it is a non-appointment, enter the starting and ending dates, appointment time, and Alarm time. 
Click on the Select Date button for help with Date Selection. The Select Time button assists you in Time 
Selection. You may also add or modify a Note by clicking the Add Note or Modify Note button. To delete a 
note click the Delete Note button.

After having entered the required information, click the Ok button to save the new appointment. Click 
Cancel to stop this procedure.

Related Topics

Delete an Appointment
Modify an Appointment
Reschedule an Appointment



Alarm

Alarms are used to remind you of an appointment or event. OnTime will sound an alarm and display the 
appropriate message even if you happen to be working in another program.

The Appointment Settings option in the Options Menu allows you to select the desired alarm tune.

The alarm may be set from within either the Add a Message or Modify a Message dialog boxes. First turn 
on the Alarm and then select the number of minutes prior to the event you wish the alarm to sound. Enter 
0 minutes to have the alarm sound at the appointment time.

An appointment with an alarm attached will have the alarm symbol  to the left of the appointments time.

When the alarm sounds a box appears displaying the appointment message, and time. To turn off the 
alarm click the Off button. Clicking the Snooze button will turn off the alarm and sound it later.
Related Topics

Add an Appointment
Day Planner
Modify an Appointment



Appointment Settings

Selecting this menu option displays the Appointment Settings dialog box. Here you may customize some 
of OnTime's features, as well as activate both pager and wave file support.

An explanation of each of the areas in this dialog is provided below.    Simply click on one of the green 
arrows to display information about the item it is pointing to.

Related Topics

Alarm
Color Customization
Day Planner
Display Settings
Font Selection
Pager Options



Archive Messages

The Archive Messages box displays archived messages retrieved with the archive search function.

The message date, Category, Frequency, Time or Priority, and a partial message. The complete Message
is displayed in the Full Message box below.

The buttons at the bottom of the Archive Messages box allow you to Delete an archive message, Print the
list of messages, return to the Review Archive box to use different Search Options, or Cancel the search.

Related Topics

Delete an Appointment



Autostart

Autostart allows you to automatically start OnTime each time MS-Windows is loaded. If this option is on a 
check mark will appear to the right of the word Autostart

This feature may be enabled or disabled as desired by clicking on it.

Related Topics

Display Settings



Categories

All messages or appointments are placed into categories. Categories allow easy grouping of 
appointments. These groups may be selected for display and printing purposes.

OnTime comes with several built in categories, you may add up to a total of 30 categories by using the 
Category Maintenance functions.

Category Selection enables you to select which categories the Day Planner is to display.

Related Topics

Add an Appointment
Modify an Appointment
Print



Category Maintenance

This dialog box is opened by selecting Category Maintenance from the Category Menu. It is used to 
maintain categories and their appointments. It is here that you may create new categories, or modify 
existing ones.

All available categories are displayed in the Categories box on the left.

To add a new category click the Add button and enter the new category name and abbreviation.

To modify an existing category select the desired category from the box on the left and click the Modify 
button. You will be prompted for the modified name and abbreviation.

Delete will remove the selected category and all appointments in it. Before you use this option make sure 
you no longer need these appointments, or that you have transferred them to another category.

To transfer appointments from one category to another click the Transfer button. You will be prompted for 
the category to transfer from and the category to transfer to.

Once your maintenance is complete, click the Ok button to close the dialog box.

Related Topics

Categories
Category Selection



Category Selection

To set up the categories to be displayed by the Day Planner selected mode use this option. Selected 
mode displays a mixture of categories that you select.

The Selected Mode Categories box displays all available categories in a box on the left. This box is 
opened by selecting Selected Mode Categories from the Category menu. You may select or deselect any 
of these either by clicking the mouse cursor on it, or by clicking the Select and Remove buttons.

Clicking the Select All button will select all categories.

Click the Ok button when your selection is complete.

Related Topics

Categories
Category Maintenance



Clipboard

The Clipboard is a MS-Windows function that enables copying and moving data across programs and 
Windows screens.

OnTime uses the clipboard in two ways. It may be used as a means of rescheduling an appointment by 
highlighting a message and selecting Cut or Copy from the Edit Menu. Cut removes the message and 
places it in the clipboard, Copy makes a copy into the clipbaord and leaves the original message intact. 
The message remains in the clipbaord until it is Pasted into its new location.

The OnTime notepad uses the Clipboard as a means of moving and copying data. Refer to you MS-
Windows documentation for details on using this function.

Related Topics

Notes



Color Customization

You may customize most of OnTime's screen colors by selecting the Colors option from the Options Menu
to open the OnTime Color Scheme dialog box.

Here you may select or modify a color scheme. Once you have selected a color scheme from the drop 
box click the Ok button. Click the Cancel button to ignore changes and exit the dialog box.

To edit a color scheme click the Edit Scheme button. The OnTime Custom Color Scheme box displays a 
palette of available colors to the right. The left of the box shows a small simulation of the OnTime screen 
so that you may see your color changes take effect.

To change any of the screen colors, you must first select the item you wish to change from the Selected 
Screen Element list or click on it in the simulated screen on the left. You may then click on the desired 
color in the color palette and click the assign key.

To change the palette colors click on the color to change and then click on the Custom Colors button. You 
will then be able to adjust the red, green, and blue ration within that color. This way you have endless 
combinations of colors available.

To reset the colors to their default color set, click on the Default button. To accept your new color set click 
the Ok button. Click Cancel to ignore the changes made.

Related Topics:

Appointment Settings
Display Settings
Font Selection



Date Selection

There are several ways to select a date. Clicking the  and 

 buttons on the bottom left of the screen will take you back or forwards one day at a time. The Today 
button quickly returns you to Today's date.
You may also click on any date in the three calendars at the bottom right of the screen. The center 
calendar shows the currently selected month. The other two calendars are the month before and after the 
currently selected month.
The Select Date button (both at the bottom of the screen and in some dialog boxes) displays the Select 
Date dialog Box. This box displays a set of calendar cards. You may select any card by clicking on it. 
Likewise a date may be selected by clicking on it. Move through the calendars by clicking on the Month 
and Year selection buttons. Click Today to return immediately to Today's date. After having made your 
selection, click Ok to go to the new date.
Related Topics

Time Selection



Day Planner

The Day Planner is the focal point of the OnTime screen. It displays all your appointments and to-do lists 
for any given day.

The Day Planner is divided into several areas. Briefly these are:

The Menu bar at the top gives you access to OnTime functions and help.

The days events or to-do lists are displayed in the appointments area. Appointments with an attached 
Alarm have the alarm symbol  to their left. Events marked as critical have a 

 to their left. Appointments with attached Notes are bent over at the top right corner. You may click here 
to view or modify the note.
Above the appointments area are buttons that allow you to select the Category of appointments or 
messages you wish to see. You may select, Appointments, Non-Appointments, Selected categories, or All
categories. Selected categories are a combination of categories that you may set up with the Category 
Selection function.

The grid on the right displays a graphic view of allocated time. Time in use is blocked out. Current time is 
also marked with a block. In this area the mouse cursor becomes a magnifying glass as displayed on the 
left. By clicking this cursor over any blocked out time span, the messages attached to that time will be 
displayed.

The bottom left of the screen contains buttons that enable control and manipulation of your calendar. Click

 to go back a day, 

 to go forwards a day. Today will return you immediately to Today's date.
Click Add to Add an Appointment, Modify to Modify an Appointment, Delete to Delete an Appointment, and
Reschedule to Reschedule an Appointment. Click the Select Date button to access the Date Selection 
dialog box. To perform a Keyword Search click the Search button.

The Print button will display the Print menu.

The Week button will display the Week Grid.

The Month button will display the Month Grid.

The bottom of the screen displays three calendars. The currently selected month is displayed in the 
center calendar. The previous month is to the left, and the next month is to the right. You may click on any
day in these calendars to go to that date.

Related Topics



Display Settings
Mouse



Delete an Appointment

When appointments or messages are no longer needed they may be deleted. To delete an entry it must 
first be highlighted. Then either click on the Delete button or select Delete from the Edit Menu.

If the record to be deleted is not a recurring record the Delete Record dialog box will appear. You are then
able to select whether or not you wish to Delete this record, and whether or not you wish to Archive it for 
future reference.

If the record is a recurring record you will be prompted as to whether you want just this occurrence 
deleted, all occurrences, or all future occurances.

Related Topics

Add an Appointment
Modify an Appointment
Reschedule an Appointment



Dialer

The OnTime Dialer dialog appears when you highlight an appointment/TO-DO item, etc. that contains 
more than one (phone) number and select the Dial! menu command.    The OnTime Dialer dialog allows 
you to choose which of the numbers should be dialed.    This dialog will only appear if there are multiple 
numbers in the message.    If a message contains only one number, selecting Dial! will automatically dial 
that number without displaying the OnTime Dialer dialog.

An explanation of each of the areas in this dialog is provided below.    Simply click on one of the green 
arrows to display information about the item it is pointing to.

Note:
If one of the numbers displayed in the OnTime Dialer dialog is an extension, you can have the dialer 
automatically dial the extension for you after dialing the phone number.    Click the Dial button that 
precedes the phone number.    A message will appear informing you that the number is being dialed.    
When the number has been dialed, click the Done button, then click the Dial button that precedes the 
extension.

Related Topics

Dialer Selection
Dialing Options



Dialer Options

The Phone Dialer Options item allows you to select a supported phone system and indicate the specific 
dialing options.    If, while installing OnTime, you indicated that you had installed AT&T PassageWay(TM) 
Solution software and wish to use the automatic dialing capabilities, the default Dialer Type will be AT&T 
PASSAGEWAY.

If you did not specify that you wanted to use the automatic dialing capabilities when installing OnTime, the
default Dialer Type will be NONE.    You must select AT&T PASSAGEWAY if you intend to use the 
automatic phone dialer.

OnTime can dial phone numbers that are typed into the Message or Note areas.    If you set an alarm for 
an appointment with a phone number in the Message, you can have OnTime dial that phone number 
when the alarm rings.    Also, if you perform a Search or Review Archive operation, you can have OnTime 
dial the phone number in the Message of the item that is located.

Related Topics

Dialer
Dialing Options
Dialer Selection



Dialer Selection

Before you can successfully use the OnTime automatic phone dialer, you must select one of the 
supported systems.    To use the automatic phone dialing capabilities, AT&T PASSAGEWAY must be 
selected as the Dialer Type.

An explanation of each of the areas in this dialog is provided below.    Simply click on one of the green 
arrows to display information about the item it is pointing to.

Once you have selected a supported phone system, you should click on the Setup... button to specify the 
default Dialing Options.    Refer to Related Topics for more information on specifying Dialing Options.

OnTime can dial phone numbers that are typed into the Message or Note areas.    If you set an alarm for 
an appointment with a phone number in the Message, you can have OnTime dial that phone number 
when the alarm rings.    Also, if you perform a Search or Review Archive operation, you can have OnTime 
dial the phone number in the Message of the item that is located.

Related Topics

Dialing Options
Dialer



Dialing Options

The Dialing Options dialog is displayed when you click the Setup... button in the Dialer Selection dialog.    
It will contain a set of default option settings, but you may customize them as desired.

An explanation of each of the areas in this dialog is provided below.    Simply click on one of the green 
arrows to display information about the item it is pointing to.

Related Topics

Dialer Selection
Dialer



Display Settings

OnTime allows you to customize the way it displays your information. Select Display from the Options 
Menu to open the Display Settings dialog box to make these changes.

You may wish to view your Week Grid immediately upon entering OnTime. To do so, click the check box 
marked Display Week Grid First on. You may click this box again to turn this option off. To increase your 
message area size in the Day Planner screen you might wish to turn off the Appointment Grid. You may 
do so by clicking on the Display Appointment Grid check box. Click there again to turn this option back on.

Owner Name is the name of the OnTime user. This name appears to the right of the status line at the 
bottom of the OnTime screen.

You may also select the Default Category Mode. This option only sets the Category that the Day Planner 
screen displays when you start OnTime. Of course you may select any other Category for viewing while in
OnTime itself.

There are two orders in which OnTime can display messages. Select either Category or Priority by 
clicking the button to the left of the desired order.

The format that dates are displayed in may be either Standard or European. Select the format you wish 
by clicking the button to the left of these options.

Time Format may also be customized. Select either Standard or Military formats.

Once your customization is complete click the Ok button to accept the settings. Click the Cancel button to 
discard your changes.

Related Topics:

Appointment Settings
Color Customization
Font Selection



Download to Stand Alone OnTime

Note:
Only available in the Reconciliation version of Stand Alone OnTime.

To make a copy of your calendar for use with a stand alone version of OnTime, select this option from the 
Tools Menu.

You will be prompted for the stand alone file path. Enter the path, and click OK to start the download. 
Click Cancel to abort.

Related Topics

Enable Transaction Tracking
Reconciliation
Upload to Network OnTime



Enable Speed Dialing

OnTime provides two different methods by which you may use the automatic phone dialer.    Using the 
standard method, you highlight a message (Appointment, Non-Appointment, etc.) that contains a valid 
phone number, then select the Dial! menu command.

To use the speed dialing method, you must enable speed dialing on the Options menu.    Then, each time 

you position the pointer over a (phone) number, the pointer will change to the Phone, , cursor.    
While the Phone cursor is displayed, simply click the left mouse button and OnTime will automatically dial 
the phone number for you.

By default, the speed dialing option will be enabled, represented by the check mark to the left of the item.  
You may disable it, if desired, by clicking the Enable Speed Dialing option.    If you disable this option, the
check mark will no longer appear before it.    Also, if speed dialing is disabled, the pointer will not change 
to the Phone cursor when it is positioned over a (phone) number.

When speed dialing is enabled, cursor response and speed may be diminished if you have many phone 
numbers listed in the Day Planner.    Disabling speed dialing will return the cursor speed and response to 
normal.

Related Topics

Dialing Options
Dialer Selection



Enable Transaction Tracking

Note:
Only available in the Reconciliation version of Stand Alone OnTime.

Transaction tracking is the process of logging calendar changes that will be used by the reconciliation 
utility. This Tools Menu option is only selectable after a Download To Stand Alone OnTime.

Transaction tracking is usually left on to ensure that all changes are tracked, if however you want to 
prevent OnTime from tracking specific changes, you may turn this option off before the change is made. 
Make sure however that you re-enable Transaction Tracking as soon as the change is made, otherwise 
OnTime will be unable to reconcile subsequent calendar changes.

Related Topics

Upload to Network OnTime



Exit OnTime

Select this option to close OnTime.

Alarms will not sound if OnTime is closed. If you have an Alarm set to sound you will be prompted for 
confirmation before OnTime is closed.

Related Topics

File Menu Commands



Export

OnTime can export calendar data to an external text file or to a palmtop computer. Select Export from the 
Tools Menu to display the Export dialog box.

The instructions for exporting to a file differ from those for exporting to a Palmtop.    Click on one of the 
following options (or the corresponding button) to learn more about that type of export operation.

Export (to file)

Export (to Palmtop)
Related Topics

Import



Export (to file)

When exporting to a file, you may export to a fixed length ASCII file, or from a keyword delimited file.    
Exporting to a file allows you to use OnTime information in other applications like word processors or 
spreadsheets, to generate billings, for example.

The Export dialog is displayed below.    For information on any of the possible options, click the green 
arrow pointing to the option in which you are interested.

Related Topics

Import
Export (to Palmtop)



Export (to palmtop)

When exporting to a palmtop computer, you may export to any of the palmtop computers supported by 
OnTime.    Check the New Features Guide for a list of the supported palmtops. Click the Palmtop button 
then specify the palmtop you are using and the COM port and date range.    Only Appointments will be 
exported, so you will not need to select a category.

The Export dialog is displayed below.    For information on any of the possible options, click the green 
arrow pointing to the option in which you are interested.

Related Topics

Import
Export (to file)



Font Selection

You may change the size of the Day Planner font with this option. Select the size that is most comfortable 
for you to work with.

There are four sizes to choose from. Select either Small, Medium, Large, or the System default. As you 
make a selection you will see the selected size displayed. Selecting a smaller size will allow OnTime to 
display more information at one time.

Click Ok to accept the new size.

Related Topics:

Appointment Settings
Color Customization
Display Settings



Frequencies

Messages and appointments in OnTime may be single or recurring events. You tell OnTime the type of 
record you desire by selecting a frequency. This is done in the Add a Message, or Modify a Message 
dialog boxes.

OnTime supports these frequencies:

Single Records that appears only once.

Weekly Records that will appear weekly on the selected day.

Bi-Weekly Records that will appear every 2 weeks on the selected day.

Monthly Records that appear each month on the selected day.

Quarterly Records that appear every 3 months.

Semi-Annual Records that appear every 6 months.

Yearly Records that appear on a given date every year.

Auto-Rollover Non-appointment records that start appearing on the date specified, and roll over 
every day until they are deleted or archived.

Variable Days # may be any number of days between 1 an 255. (Eg. every 3rd day would be 
N3).

Some frequencies require additional parameters. You will be prompted for these when needed.

Related Topics

Add an Appointment
Modify an Appointment



Import

OnTime can import calendar data from external text files or from Palmtop computers. Select Import from 
the Tools Menu to display the Import dialog box.

The instructions for importing from a file differ from those for importing from a Palmtop.    Click on one of 
the following options (or the corresponding button) to learn more about that type of import operation.

Import (from file)

Import (from Palmtop)
Related Topics

Export



Import (from file)

When importing from a file, you may import from a fixed length ASCII file, or from a keyword delimited file.

The Import dialog is displayed below.    For information on any of the possible options, click the green 
arrow pointing to the option in which you are interested.

Related Topics

Export
Import (from Palmtop)



Import (from Palmtop)

When importing from a palmtop computer, you may import from any of the palmtop computers supported 
by OnTime.    Check the New Features Guide for a list of the supported palmtops. Click the Palmtop 
button then specify the palmtop you are using and the COM port.

The Import dialog is displayed below.    For information on any of the possible options, click the green 
arrow pointing to the option in which you are interested.

Related Topics

Export
Import (from file)



Keyword

Keywords are words, up to the first 15 characters, of any Message. Performing searches on keywords 
rather than on full messages is considerably quicker.

You might want to establish a system whereby the keyword section of the message contains information 
that would allow easy search and retrieval. Perhaps always put the contact name at the beginning of the 
message. This way you could search for all references to that contact name.

Related Topics

Keyword Search
Review Archive



Keyword Search

To locate a message anywhere within OnTime use the Keyword Search function. To do this either click 
the Search button at the bottom of the Day Planner screen, or select Keyword Search from the Edit Menu.

Use the OnTime Keyword Search dialog box to set up your searches, and to view the results. Enter the 
text to search for in the Search For field. You may then select whether to search Keywords only, or the 
Full Message. To perform a Case Sensitive search click the Case Sensitive check box on. When you 
have set up the search click the Search button to conduct the search.

The partial retrieved messages, their dates, times, and frequencies are displayed in the Messages for 
Keyword box. The Full Messages text is displayed in the box to the right.

You may highlight any of these messages and click on the buttons at the top right to perform several 
functions. Click Modify, Delete, or Reschedule to manipulate the highlighted message. Click Add to Add 
an Appointment. To print the retrieved messages click the Print button.

Click Goto Selected Date to go to the date of the highlighted message.

Related Topics

Delete an Appointment
Modify an Appointment
Reschedule an Appointment



Message

The message area of an appointment or to-do list entry may contain up to 80 characters of text. This 
appears in the Day Planner, and Week Grid and Month Grid detail views, and on all reports.

The first 15 characters of the message area is that message's Keyword,

If more than 80 characters are required you will have to attach a Note.

Related Topics

Add an Appointment
Keyword Searches
Modify an Appointment
Review Archive



Modify an Appointment

There are several ways to modify an appointment or message. One way is to highlight the desired 
appointment in the day planner and click the mouse button or press enter. Alternatively you may click the 
Modify button at the bottom of the screen, or select Modify from the Edit Menu.

Any of these options will open the Modify A Message dialog box.

If the appointment is a recurring event you will be prompted as to whether to modify this ocurrance, all 
occurances, or all future occurances. Make your selection and then select Ok, or click Cancel to stop the 
modification.

Here you may modify a Message, use the Category Selection to select a Category, select a Frequency, a 
Priority if it is a non-appointment, modify the starting and ending dates, appointment time, and Alarm time.
Click on the Select Date button for help with Date Selection. The Select Time button assists you in Time 
Selection. You may also add or modify a Note by clicking on the Add Note or Modify Note button

After having entered the required information, click the Ok button to save the modified appointment. Click 
Cancel to stop this procedure.

Related Topics

Add an Appointment
Delete an Appointment
Reschedule an Appointment



Month Grid

The Month Grid displays time usage for a month at a time. Time that is allocated is blocked out. and may 
be viewed in detail if desired. To get to the Month Grid click the Month button at the bottom of the Day 
Planner or Week Grid screens.

To view any allocated time block in detail, move your mouse cursor into the Month Grid. The cursor will 
turn into a magnifying glass as displayed on the left. Position the cursor over any blocked out time slot 
and hold down the mouse button. The time usage in detail will be displayed.

The Print button will display the Print menu.

The Day button will display the Day Planner.

The Week button will display the Week Grid.

Related Topics

Date Selection
Mouse



Notes

OnTime allows you to attach Notes to appointments and messages. A record with a note attached is 
displayed in the Day Planner as folded over in the top right corner. To view or modify the note click on this
fold.

The Note dialog box displays the message in the upper window, and lets you attach a note in the lower 
window. The menu bar at the top has three options. The File menu is used to save or print your note, and 
Printer Setup. The Edit menu contains Clipboard functions, an Undo command to undo the last change 
made, and an option to enable or disable word wrap. The Search menu allows you to search your note for
specific text.

Related Topics

Add an Appointment
Modify an Appointment



Pager Options

The Pager Options dialog is where you will specify the program path for the WINBEEP.EXE file and your 
subscriber name, if you intend to use the pager facilities.

An explanation of each of the areas in this dialog is provided below.    Simply click on one of the green 
arrows to display information about the item it is pointing to.



Print Options

Print options are available for all of the different OnTime printouts, but each printout provides a slightly 
different set of options. For details on the print options available for each of the printouts, simply click on 
the printout name or corresponding button below.

Day Planner

Week Grid

Month Grid

Trifold

Duplex

All Messages in System

All Messages through Today
Related Topics

Print Preview
Printer Setup
Printing



Day Planner Print Options

The Day Planner Print Options dialog is displayed below.    For information on any of the possible options, 
click the green arrow pointing to the option in which you are interested.



Week Grid Print Options

The Week Grid Print Options dialog is displayed below.    For information on any of the possible options, 
click the green arrow pointing to the option in which you are interested.



Month Grid Print Options

The Month Grid Print Options dialog is displayed below.    For information on any of the possible options, 
click the green arrow pointing to the option in which you are interested.



Trifold Print Options

The Trifold Print Options dialog is displayed below.    For information on any of the possible options, click 
the green arrow pointing to the option in which you are interested.



Duplex Print Options

The Duplex Print Options dialog is displayed below.    For information on any of the possible options, click 
the green arrow pointing to the option in which you are interested.



All Messages in System Print Options

The All Messages in System Print Options dialog is displayed below.    For information on any of the 
possible options, click the green arrow pointing to the option in which you are interested.



All Messages through Today Print Options

The All Messages through Today Print Options dialog is displayed below.    For information on any of the 
possible options, click the green arrow pointing to the option in which you are interested.



Print Preview

OnTime allows you to view your reports on the screen. To do this click the Preview button available from 
the print dialog boxes.

You may then choose to zoom in and see the report in detail, or zoom out to see the whole report at once.
You may move the report on the screen with the hand cursor shown on the left. To print the report directly 
from within the preview window, click the Print button.

Related Topics

Printing
Printer Setup



Printer Setup

Before you can print reports you must have installed and selected a printer. Selecting Printer Setup from 
the File Menu will list your installed printers. Select one of these and click the Ok button. To open the MS-
Windows printer setup dialog box click the Setup button.

This dialog box is specific to each printer. Make your selections and then click Ok to accept them.

Related Topics

Print Preview
Printing



Printing

OnTime prints attractive and highly useful reports. Clicking on the Print icon, or selecting Print from the 
File Menu displays a menu of available reports.

Select the report you wish to print to open that reports dialog box. You will be presented with buttons 
allowing you to Print or Cancel.

If you are printing a Week Grid, Month Grid, or Tri-Fold Print, you will also be able to preview the report on
the screen. Click the Preview button to use this function.

Most reports are highly configurable. Pressing the Options button in those dialog boxes that have one will 
allow you to customize the reports. Some options are page orientation, paper source, typeface size, page 
margins, and number of copies. You may also customize columns, indentation, whether or not to print 
calendars and wrap text if applicable.

Related Topics

Printer Setup



Priority

Non Appointment messages may be assigned priorities. These are optional values, and you may sort 
your lists by priority if you wish.

Valid priority entires are 1-99 and A-Z. 1 is the highest priority, Z is the lowest. Leave the priority field 
blank if the message has no priority.

To sort by priority, select Priority for the Sort Order in the Display Settings dialog box.

Related Topics

Add an Appointment
Categories
Frequencies
Modify an Appointment



Reconciliation

Note:
Only available in the Reconciliation version of Stand Alone OnTime.

Reconciliation provides the ability to download a copy of your network calendar so that you can use it with
a stand alone version of OnTime. This allows you to maintain your calendar via a stand alone copy of 
OnTime while you are away from your network, and, in addition allows changes to be made to the 
network version as well. These two calendars may then be merged back together using the upload option.
This option allows you to reconcile any scheduling conflicts that may have occurred between the network 
and stand alone calendars. 

Reconciliation is accomplished via transaction logging. This is a feature that is automatically enabled 
when you download your file from your network version of OnTime. The transaction logging records all 
calendar changes to ensure that they may be reconciled at a later date.

Related Topics

Upload to Network OnTime
Download to Stand Alone OnTime
Enable Transaction Tracking



Reschedule an Appointment

There are several ways to reschedule an appointment. You may highlight the desired appointment and 
click the Reschedule button, or select Reschedule from the Edit Menu. You may also reschedule an 
appointment located with the Keyword Search, or use the Cut or Copy commands to use the Clipboard.

Any of these options will open the Reschedule dialog box. This box takes two forms. It can be a small 
single line box allowing you to see the screen beneath. By clicking the Show button the full dialog box will 
be displayed and you will be able to see the full appointment message. To reduce it again to the smaller 
size, click the Hide button.

The Reschedule dialog box prompts you for the date and time to move the appointment to. You may type 
this in the field, or simply select that day and time using regular Date Selection techniques.

Once you have selected the new date and time click the Reschedule button. You will be prompted as to 
whether or not you wish to delete the previous occurrence. 

Related Topics

Add an Appointment
Delete an Appointment
Modify an Appointment



Review Archive

Whenever an appointment is deleted OnTime will prompt you as to whether or not to Archive it. The 
Archive stores copies of deleted appointments and messages for future reference.

Selecting Review Archive from the Archive Menu displays the Review Archive box. Here you may select 
the archived messages you wish to review.

Date Options are used to narrow down the list of archived records. You may select All Messages, Todays 
Messages, Current Months Messages, or a Selected Date Range. If you choose a Selected Date Range 
you will be prompted for a starting and ending date.

If you wish to Search with keyword, click on this option in the Keyword Options area. You will then be 
prompted to enter the keyword, and select whether or not the search is case sensitive, and whether to 
search on keywords only. If you turn the Keywords Only option on, OnTime will only search up to the first 
fifteen characters of each message. This is quicker than a regular search.

You may also select which categories to search through. Either click on All Categories, or Selected 
Categories. If you choose the latter you will be able to select the desired categories in the box on the 
right.

Once you have made your selections, click the Ok button to display the Archive Messages box.

Related Topics

Delete an Appointment



Time Selection

Clicking on the Select Time button in the Add or Modify dialog boxes will display the Time Selection dialog
box. This enables quick and simple selection of appointment starting time and duration.

At the top of the box is a time grid. Already allocated time is marked blocked out at the bottom of the grid. 
To mark your appointment starting time drag the upper triangle to the desired time with the watch cursor 
as shown to the left and release the mouse button. Do the same with the lower triangle to set the ending 
time.

The entire block of time may be rescheduled by dragging it with the hands cursor as shown to the left.

These times may be set or adjusted using the fields below. You may enter a time in the correct box, or 
adjust it by clicking on the up and down arrows to the right of each field.

For a Notime appointment, click the Notime button.

Once time selection is complete click Ok to accept or Cancel to ignore settings.

Related Topics

Date Selection



Upload to Network OnTime

Note:
Only available in the Reconciliation version of Stand Alone OnTime.

To bring the changes made in your stand alone OnTime onto the network, and reconcile the calendars, 
select this option from the Tools Menu.

You will be prompted for the stand alone file path. Enter the path, and click OK to start the download. 
Click Cancel to abort.

During the reconciliation process, OnTime will automatically reconcile your calendars, except where there
is a conflict or overlap. If that occurs OnTime will prompt you as to how to proceed.

CONFLICTING APPOINTMENTS. OnTime will display the conflicting appointments and will allow you to 
select ACCEPT RECORD FROM STAND ALONE or    ACCEPT RECORD FROM NETWORK.

OVERLAPPING APPOINTMENTS. OnTime will display the overlapping appointment and allow you to 
select IGNORE THE OVERLAP (ADD THE STAND ALONE RECORD ANYWAY) or DO NOT ADD THE 
STAND ALONE RECORD TO THE NETWORK CALENDAR.

Once you have made your selection click the OK button.

Related Topics

Enable Transaction Tracking
Reconciliation
Download to Stand Alone OnTime



Week Grid

The Week Grid displays time usage for a week at a time. Time that is allocated is blocked out and may be
viewed in detail if desired. To get to the Week Grid click the Week button at the bottom of the Day Planner
or Month Grid screens.

 To view any allocated time block in detail, move your mouse cursor into the Week Grid. The cursor will 
turn into a magnifying glass as shown to the left. Position the cursor over and blocked out time slot and 
hold down the mouse button. The time usage in detail will be displayed.

The Print button will display the Print menu.

The Day button will display the Day Planner.

The Month button will display the Month Grid.

Related Topics

Date Selection
Mouse



Clicking the Done button will exit from the OnTime Dialer dialog.    You 
may exit after you have dialed the desired number(s), or you may exit 
without having dialed any numbers.



Clicking the Dial button will automatically dial the number listed directly to
the right of that button.    If the number is an extension number, you 
should have OnTime dial this number after it has dialed the phone 
number to which the extension pertains.    For an alternate method of 
handling extension numbers, click on the Valid phone punctuation 
area.

Any time the Speakerphone light is lit on your phone, a Hang up button 
will appear.    You may click this button at any time to terminate the phone
call.    The Hang up button only appears while you are using the 
speakerphone.    If you lift the receiver, the Hang up button will disappear.



Clicking the OK button will save any modifications you made in the dialog
and exit.    You must click the OK button to save your settings.    If you do 
not, your modifications will be lost.



Clicking the Cancel button will exit from the dialog without saving any of 
the modifications you made.



Prefix for 10 digit number

This area allows you to specify the default prefix for 10-digit numbers that
you will be dialing.    A 10-digit number is comprised of a 7-digit phone 
number and a 3-digit area code    This is important because some 
organizations require that you first dial a number, like 9, in order to get an
outside phone line.    And, since all long distance phone calls require that 
you include the 1- prefix, this too can be added to the default prefix.

The default setting, 9-1-, assumes that you must dial 9 for an outside 
line, and that long distance phone calls require the 1- prefix.    If these 
assumptions are not accurate for you, modify the 10-digit prefix as 
desired.

Note:
The prefix you specify as the default will automatically be dialed any time
you have OnTime dial a 10-digit phone number for you.    Do not include 
the default prefix in your OnTime messages.    If you are creating a TO-
DO item that requires a phone call be made, type the phone number like 
this: 313-123-4567.    OnTime will automatically add the 10-digit prefix 
when it dials the number, so the actual number dialed will be 9-1-313-
123-4567.



Prefix for 7 digit number

This area allows you to specify the default prefix for 7-digit numbers that 
you will be dialing.    A 7-digit number is comprised of a 7-digit phone 
number (no area code)    This is important because some organizations 
require that you first dial a number. like 9, in order to get an outside 
phone line.

The default setting, 9-, assumes that you must dial 9 for an outside line.   
If this assumption is not accurate for you, modify the 7-digit prefix as 
desired.

Note:
The prefix you specify as the default will automatically be dialed any time
you have OnTime dial a 7-digit phone number for you.    Do not include 
the default prefix in your OnTime messages.    If you are creating a TO-
DO item that requires a phone call be made, type the phone number like 
this: 123-4567.    OnTime will automatically add the 7-digit prefix when it 
dials the number, so the actual number dialed will be 9-123-4567.



Prefix for 800 number

This area allows you to specify the default prefix for 800 numbers that 
you will be dialing.    An 800 number is comprised of a 7-digit phone 
number and the 800 area code    This is important because some 
organizations require that you first dial a number, like 9, in order to get an
outside phone line.    And, since all long distance phone calls require that 
you include the 1- prefix, this too can be added to the default prefix.

The default setting, 9-1-, assumes that you must dial 9 for an outside 
line, and that long distance phone calls require the 1- prefix.    If these 
assumptions are not accurate for you, modify the 800 number prefix as 
desired.

Note:
The prefix you specify as the default will automatically be dialed any time
you have OnTime dial an 800 number for you.    Do not include the 
default prefix in your OnTime messages.    If you are creating a TO-DO 
item that requires a phone call be made, type the phone number like this:
800-123-4567.    OnTime will automatically add the 800 number prefix 
when it dials the number, so the actual number dialed will be 9-1-800-
123-4567.



Valid phone punctuation

This area allows you to specify the punctuation characters that will be 
considered valid in phone numbers you type.    By default, valid phone 
punctuation characters include the left and right parentheses ( ), the 
hyphen - and a blank space.    You may customize the valid phone 
punctuation as desired.

Tip:
The comma (,) has special meaning.    The comma signifies a 1 second 
time delay.    For example, if you include the comma as one of the valid 
phone punctuation characters, you could type the following phone 
number as part of a TO-DO list item:    (313) 123-456,,,,,,,789.    When 
dialing this number, OnTime would dial the area code and phone number,
wait 7 second (one for each of the seven commas) and then dial the 
extension number.



Minimum number of digits

This area allows you to specify the minimum number of digits a number 
should contain in order to be considered a phone number.    By default, 
the minimum number of digits is set to three (3).    This means that any 
number with 3 or more digits will be recognized by OnTime as a phone 
number.    This would mean that even $231 would be recognized as a 
phone number.

In order to restrict this, you may increase the minimum number of digits.   
However, do not increase this threshold above 2 or 3 if you tend to use 2-
or 3-digit extension numbers.    For an alternate method of handling 
extension numbers, click on the Valid phone punctuation area.

Note:

You may not specify zero (0) as the minimum number of digits.



Valid 800 prefix strings

This area allows you to specify the 800 strings that will be considered 
valid in 800 numbers that you type.    By default, the following 800 strings 
are valid: 800 and (800).    These default 800 strings, coupled with the 
prefixes for 800 numbers should accommodate all variations of 800 
numbers.    Do not include any additional 800 prefix strings.

Unlike the prefixes for 7- and 10-digit phone numbers and 800 numbers, 
you must include one of the valid 800 prefix strings in the 800 numbers 
you type; that is, you must include the 800 area code.



Dialer Type

The Dialer Type is where you will select one of the systems that support 
OnTime's automatic phone dialing capabilities.    If you intend to use the 
automatic dialing facilities, AT&T PASSAGEWAY must be selected.



Executable Path

The Executable Path is not used for the AT&T PASSAGEWAY system, 
which is why it remains grayed.    When other systems are supported, the
Executable Path may be necessary.



The Browse button allows you to select the executable path from a dialog
box instead of having to type it into the Executable Path text area.    
Because AT&T PASSAGEWAY does not use the Executable Path, the 
Browse button will remain grayed.



The Setup... button allows you to specify the Dialing Options for the 
dialer type you selected.    For more information on setting dialing options
refer to the Dialing Options help topic.



Start Time

The Start Time allows you to specify the time from which the Day Planner
should begin.    By default, the Day Planner will begin from 8:00am, 
however you may modify the Start Time as desired.

The Start and End Times only regulate what is displayed in the Day 
Planner.    Regardless of the Start and End Times you specify, you will 
still be able to add appointments before the Start Time or after the End 
Time.



End Time

The End Time allows you to specify the daily end time for the Day 
Planner.    By default, the Day Planner will display time slots through 
5:00pm, however you may modify the End Time as desired.

The Start and End Times only regulate what is displayed in the Day 
Planner.    Regardless of the Start and End Times you specify, you will 
still be able to add appointments before the Start Time or after the End 
Time.



Units

The Units radio buttons define the increments in which the Day Planner 
will be divided.    By default, the Day Planner is divided into 60 minute 
increments, however you can choose to display the Day Planner in 30 or 
15 minute increments, if desired.

The Units only regulate the time intervals displayed in the Day Planner.    
You may actually schedule appointments at intervals as small as 1 
minute.



OnTime's Alarms

OnTime provides you with several different alarm tunes.    You may 
choose one of these as the tune for alarms you set.    The various 
OnTime alarms are listed in the Alarm Tune drop-down list box.

To hear the selected alarm, click in the Test Tune check box.    The tune 
will be continuously repeated until you click in the Test Tune check box 
again.



Wave Files

In addition to the standard alarm tunes, OnTime also support wave files.   
Wave files are third-party sound files that may be used in place of the 
OnTime alarms.    In order to use wave files as alarm tunes you must 
have multi-media capabilities and own some wave files.    OnTime does 
not provide any wave files.

If you choose to use wave files, you must specify the drive, path and file 
name of the wave file to use, either by typing that information into the 
Alarm Tune text box or by selecting it using the Browse button.



Alarm Tune

The Alarm Tune text box displays the name of the selected OnTime 
alarm or wave file that will be used as the alarm tune.    If the OnTime's 
Alarms radio buttons is active, the information in the Alarm Tune will be 
the name of one of the standard OnTime alarms.    If the Wave Files radio
button is active, the Alarm Tune text box will display the name of the 
third-party wave file that will be used as the alarm sound.



Alarm Snooze

OnTime's snooze feature for alarms is similar to hitting the snooze button
on an alarm clock when the alarm rings.    Alarm Snooze allows you to 
specify the number of minutes that should elapse from the time you click 
the Snooze button to the time the alarm rings again.

You may specify any interval between 0 and 99 minutes, inclusive.    



Test Tune

The Test Tune feature allows you to sample the alarm sound that you 
have selected.    This will help you determine which OnTime alarm or 
wave file sound you want to use.    When you click in the Test Tune check
box, the alarm tune will continue to be repeated until you click in the Test 
Tune check box again to switch off the Test Tune feature.



Confirm exit when alarms are active

When exiting the program, OnTime can warn you if alarms are set that 
you might miss. To enable or disable this option, click on the Confirm exit
when alarms active box.



Pager

The Pager options provide you with the capability to have OnTime page 
you each time one of your alarms rings.    In this way, you can be alerted 
to your scheduled appointments even when you are away from your copy
of OnTime, and even away from a computer.

The Pager options in this group allow you to configure the pager-
notification option, as well as switch it on and off.

In addition to OnTime, you will need the following:

Windows 3.1.    The pager options does not function with earlier versions of Windows.
WinBeep software.    OnTime will communicate with WinBeep, which will in turn dial your pager 

number.
Pager supported by WinBeep.



Pager installed

The Pager installed check box allows you to specify whether or not you 
plan to use the paging utility.    This box will automatically be checked if 
you activated the phone dialing capabilities when you installed this 
version of OnTime.

If you installed AT&T PassageWay(TM) solution after installing OnTime 
you can use the dialing capabilities by checking the Pager installed 
check box.    You should not check this box if you do not have all of the 
following:

Windows 3.1.    The pager options does not function with earlier versions of Windows.

WinBeep software.    OnTime will communicate with WinBeep, which will in turn dial your 
pager number.

Pager supported by WinBeep.
Note:

Pager installed will be grayed, indicating unavailability, if you are running 
Windows 3.0 instead of Windows 3.1.

When you click in the Pager installed check box, the Alarms Delivered By
Pager check box and the Pager Options button will automatically become
active.



Alarms Delivered By Pager

Alarms Delivered By Pager will remain grayed, indicating unavailability, 
until you click in the Pager installed check box.    Activating Alarms 
Delivered By Pager means that you will automatically be paged each 
time one of your OnTime alarms rings.    You should only switch on this 
feature just before you leave your office/home, and switch it off when you
return.

Note:

Your copy of OnTime must be running in order for the OnTime alarms to 
ring, and in order for you to be paged.



The Pager Options.. button displays a dialog in which you will specify the
pager program path and your subscriber name.    You need only specify 
the path for the WINBEEP.EXE file.    You need not include the file name 
as well.

Note:

The subscriber name text box is case sensitive, so JOHN, John and john
are treated as three different names.    Be sure to type your subscriber 
name exactly as it appears in WinBeep.



Clicking the OK button will save any modifications you made in the dialog
and exit.    You must click the OK button to save your settings.    If you do 
not, your modifications will be lost.



The Browse button allows you to select the executable path from a dialog
box instead of having to type it into the text box.    When you specify the 
path from the Browse button, you will select the WINBEEP.EXE file, 
however, only the path will be used.



Clicking the Cancel button will exit from the dialog without saving any of 
the modifications you made.



Pager Program Path

This is where you must enter the full path for WinBeep executable files; 
that is, the path where WINBEEP.EXE is located.    You do not need to 
include the WINBEEP.EXE file name in the path.



Subscriber

This is where you will enter your WinBeep subscriber name.

Note:

The subscriber name text box is case sensitive, so JOHN, John and john
are treated as three different names.    Be sure to type your subscriber 
name exactly as it appears in WinBeep.



Clicking the Test button will check that the paging feature is operating 
correctly.    The Test button should interface with WinBeep, which should, 
in turn, dial your pager number and beep you.



Click on the Page Options... button to specify additional information about the printout you are generating.
You may specify a different printer and page orientation, among other things.    These page options are 
provided by Microsoft Windows.    Please refer to your Microsoft Windows User's Manual for complete 
instructions on modifying and customizing these options.



Message Options

Message Options allows you to specify how many blank lines to insert 
between messages and how many characters to indent the messages.

Simply type in the desired figures in the boxes provided.    You may 
separate messages by as much as 9 blank lines, and you may indent 
messages by as much as 99 characters.



Margins

The Top, Bottom, Left and Right margins will contain default values.    
These default values are those that we feel will provide you with the best 
possible printout.    However, you may modify these margins, if desired.

Note:
The margins will differ depending on the printout and the Page Format 
you have chosen.    If you modify the margins, but wish to return to the 
default margins before printing, click the Load Defaults... button.



Page Formats

OnTime provides you with the capability to print the various OnTime 
printouts on three different page formats:

Standard: Tailors the printout to fit on an 8 1/2" X 11" sheet of paper.    
The page orientation (portrait or landscape) will 
automatically be selected depending on the printout 
selected.

Executive: Tailors the printout to fit on the 5 1/2" x 8 1/2" area of 
specially perforated paper.    You can then tear off the 
printed area and insert it into an "Executive" size binder.

Pocket: Tailors the printout to fit on the 3 3/4" x 6 3/4" area of 
specially perforated paper.    You can then tear off the 
printed area and insert it into a "Pocket" size binder.



Default margins will already be set for all of the different printouts.    You may modify these margins, if 
desired.    To return to the default margins, simply click the Load Defaults... button.



Font Size

OnTime allows you to specify different font sizes for printouts.    You may 
choose from Small, Medium, Large or Advanced.

If you select Advanced, click on the  button to select the 
desired font and size for each area of the printout.



The Advanced button will remain grayed unless you select Advanced as the Font Size.
Click on the Advanced button to specify the font, size and font characteristics for each area of the printout.



Show calendar

This option will include a 10-month calendar at the bottom of the printout.



Print Note with Messages

This option allows you to specify whether or not to print the Notes 
corresponding to Messages.

If you check this option, the Show Time Grid option will automatically 
become grayed, because you cannot print the time grid and notes on the 
same printout.    Also, the "Draw Boxes Around Notes" will automatically 
be checked when you check this option.



New Pages per Day

This option allows you to have each day's messages printed on a 
separate sheet of paper.



Print Ending Times/Priorities

This option allows you to have the ending times and priorities (for TO-DO
list items) included in the printout.



Show Time Grid

This option will show the time grid (for example, 8:00 am to 5:00 pm in 1-
hour increments) for each day.

Note:
This option will remain grayed, indicating its unavailability, unless you 
have selected Appointments as the category and have not checked the 
"Print Note with Messages" option.



Show Date Header

By default the header is comprised of the user name.    This option allows
you to generate printouts where the header is comprised of the user 
name and the date range for which the printout is being generated.



Skip Days with No Messages

This option allows you to print only those days that have messages.



Header on First Page Only

The Header is comprised of the user name (and the date range for which
the printout is being generated if you have checked the "Show Date 
Header" option).    By default this header information is repeated on all 
pages of the printout.

This option allows you to have the header printed only on the first page 
of the printout.



Draw Boxes Around Notes

Initially, if you check "Print Note with Messages," this option will be the 
default.    This option will automatically draw a box around each of the 
printed Notes.    To have Notes indented but not enclosed in boxes, un-
check this option.



Word Wrap Messages

This option allows you to have the text of long messages wrap to the 
next line instead of being truncated.    If you do not check this option, an 
arrow will appear to the right of truncated messages, indicating that there
is more text than is displayed.



Show Previous Week

When you have selected more than one week to print, checking the 
"Show Previous Week" option will automatically include the previous 
week as one of the selected weeks.

Note:
You must have specified more than one week in order to have this option
apply.



One Week Print Options

Checking either of the "One Week Print Options" will generate a printout 
comprised of only the selected week (one week only).

You may choose to print the time lines and/or time slots for that week.

Time lines: Will print a line between the starting and ending time of an 
appointment.

Time slots: Will include the time grid on the printout; for example, 8:00 
am to 5:00 pm in 1-hour increments.



Show Upcoming Events Box

This option allows you to include the "Birthday/Anniversaries" box in your
printout.    Upcoming events pertains only to Category 4 events 
(Birthday/Anniversaries).

Note:
Specify the number of days in the future for which you want upcoming 
events printed.    You may have upcoming events printed for up to 90 
days from the selected date.



Show Number of Days Old

This option allows you to include a figure representing the number of 
days that have elapsed since a TO-DO list event was created.    This 
figure will appear to the right of the item, and will be enclosed in 
parenthesis.



Shade Today's Messages

This option will automatically gray the background of today's messages 
in order to visually differentiate them from other messages.



Days for Upcoming Events

This is where you will specify the number of days in the future for which 
you would like to have upcoming events (birthdays/anniversaries) 
printed.    This option will remain grayed unless you check the "Show 
Upcoming Events Box" option.



Printout for Side One

This option allows you to specify the information you would like printed 
on Side 1 of a Duplex printout.

Note:
A Duplex printer will print on both sides of the sheet of paper.    You must 
have a Duplex printer in order to generate Duplex printouts.



Printout for Side Two

This option allows you to specify the information you would like printed 
on Side 2 of a Duplex printout.

Note:
A Duplex printer will print on both sides of the sheet of paper.    You must 
have a Duplex printer in order to generate Duplex printouts.



Category for Side One

This option allows you to specify the Category of events you would like 
printed on Side 1 of a Duplex printout.    The available categories will 
depend on the printout you have selected for this side.

Note:
A Duplex printer will print on both sides of the sheet of paper.    You must 
have a Duplex printer in order to generate Duplex printouts.



Category for Side Two

This option allows you to specify the Category of events you would like 
printed on Side 2 of a Duplex printout.    The available categories will 
depend on the printout you have selected for this side.

Note:
A Duplex printer will print on both sides of the sheet of paper.    You must 
have a Duplex printer in order to generate Duplex printouts.



Click the File button to export OnTime information to a file.    This allows you to copy OnTime information 
into another application like a word processor or spreadsheet.



Click the Palmtop button to export OnTime information to a Palmtop.    This allows you to continue to 
maintain your OnTime calendar while you are away from your copy of OnTime.



Format

OnTime supports two different ASCII file formats: Keyword Delimited and
Fixed Length.    Refer to the New Features Guide for the differences 
between these different formats.



Name

When you export OnTime information to a file, you must specify the file 
name.    Type in the file name you intend to use in this area.    You may 
also specify a file extension, drive and path, if desired.

Click the  button to select the drive and path instead of typing it.



Device

OnTime supports several different Palmtops.    Select the desired 
Palmtop from the list provided.



Port

When you export OnTime information to a Palmtop, you must specify the 
port.    Select the desired port from the list provided.



Clicking the Browse button allows you to select the drive and path for the export file instead of having to 
type the entire path.



Date range

Select the date range you want to export.    You may choose from the 
following ranges:

Today: All messages for today.

This Week: All messages from Sunday through Saturday of 
this week.

This Month: All messages from the first through the last day 
of this month.

*Relative Date Range: All messages for the number of days before, 
through the number of days after today.

*Absolute Date Range:All messages within the specified date range.

*    When you select this option you must also specify the number of days
before and after today or starting and ending dates in the range.    The 
printout will be inclusive of these figures.



Starting and Ending Dates
    Days Before/After Today

If you select "Relative Date Range" you must specify the number of days 
before and after today that you would like included in the printout.

If you select "Absolute Date Range" you must specify the starting and 
ending dates of the range.



Category

When you export to a file you may select the category of events that you 
would like exported.



Category

OnTime only exports Appointments to Palmtop computers.    
Consequently, the category defaults to Appointments and you cannot 
modify this.



Click the Export button to have the OnTime information exported.



Click the File button to import information into OnTime from an ASCII file.



Click the Palmtop button to import information into OnTime from one of the supported Palmtops.
Note:
Palmtop calendar information is not reconciled upon import though duplicate records are avoided.



Import Duplicates

By default, duplicate records will be ignored upon import to OnTime.    
However, you may check the Import Duplicates option to have records 
imported regardless of whether they are duplicates.



Click the Import button to have the specified information imported into OnTime.



Commands

The OnTime menus are:
File Menu
Edit Menu
Options Menu
Category Menu
Archive Menu
Tools menu
Dial! Menu Command



File Menu Commands

The File Menu contains options that allow printing and printer setup, and autostart capability.

Printer Setup
Print
Autostart
Exit OnTime

Related Topics
Archive Menu Commands
Category Menu Commands
Edit Menu Commands
Options Menu Commands



Edit Menu Commands

The Edit Menu contains options for adding, and manipulating appointments and messages, and keyword 
search.

Add
Modify
Delete
Reschedule
Cut
Copy
Paste
Delete
Keyword Search
Day View
WeekView
Month View

Related Topics
Archive Menu Commands
Category Menu Commands
File Menu Commands
Options Menu Commands



Options Menu Commands

The Options Menu is used to modify system settings, colors, fonts, and display options.

Appointment Settings
Display
Colors
Fonts
Phone Dialer Options
Enable Speed Dialing

Related Topics
Archive Menu Commands
Category Menu Commands
Edit Menu Commands
File Menu Commands
Dial! Menu Command



Category Menu Commands

The Category Menu is used for category selection and maintenance.

Appointments
Non-Appointments
Selected Mode
All Categories
Category Maintenance
Selected Mode Categories

Related Topics
Archive Menu Commands
Edit Menu Commands
File Menu Commands
Options Menu Commands



Archive Menu Commands

The Archive Menu gives you access to archived messages and appointments.

Review Archive

Related Topics
Category Menu Commands
Edit Menu Commands
File Menu Commands
Options Menu Commands



Tools Menu Commands

The Tools Menu gives you access to the OnTime tools and utilities.

Import
Export
*Upload to Network OnTime
*Download to Stand Alone OnTime
*Enable Transaction Tracking

Related Topics
Archive Menu Commands
Category Menu Commands
Edit Menu Commands
File Menu Commands
Options Menu Commands

* Only in the Reconciliation version of Stand Alone OnTime.



Dial! Menu Command

The Dial! Menu Command will automatically dial a phone number in the selected message.    In addition to
using the Dial! menu command, you may also enable the speed dialing option so that you can dial phone 
numbers with a click of your mouse.

Related Topics
Options Menu Commands
Enable Speed Dialing



Keyboard

Use the following keys in OnTime:

Key Function

Right Arrow Advance OnTime one day
Left Arrow Go back one day
Home Return to Todays date
Up Arrow Up one message
Down Arrow Down one message
PgUp Top of calendar
PgDn Bottom of calendar
Shift-Up Arrow Up one line in time grid
Shift-Down Arrow Down one line in time grid
Shift-PgUp Top of time grid
Shift-PgDn Bottom of time grid
Ctrl-D Date stamp in message area
Ctrl-T Time stamp in message area

Related Topics

Mouse Cursors



Mouse Cursors

Depending on which screen you are in, and what operation you are performing, OnTime uses different 
mouse cursors for different purposes.

The magnifying glass cursor is displayed when you move your mouse into any of the time allocation 
areas. These are the grid on the right of the Day Planner, the Week Grid, and the Month Grid.

The watch cursor is used to mark appointment starting and ending times in the Time Selection dialog box.
You may move it right or left to mark the desired time.

The hands are used to move an appointment in the Time Selection dialog box. You may move it right or 
left to the desired time slot.

This single hand cursor is used to move the Print Preview screen.

The Phone cursor is displayed when you have activated the Speed Dial feature and have positioned the 
pointer over a (phone) number in a message or personal note.    Clicking the left mouse button when the 
Phone cursor is displayed will automatically dial the phone number.

Related Topics

Keyboard




